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Migration of Your ClearQuest User Database in 7 Steps

Introduction

ClearQuest continues to be a dominant player in
the defect tracking system tool for many SPK and
Associates customers. One of the more common
administrative tasks we are asked to perform is a
user database migration. This document
describes steps required to migrate user data
from one ClearQuest database to another.

The focus is on the use of the Export/Import
tools. This is the preferred method when the
goal is to populate a modified schema in a new
location or consolidating exiting user databases

If the desire is to simply clone or relocate an
existing ClearQuest database, you would use the
Move function in the ClearQuest Maintenance
tool and ClearQuest Designer to migrate the
data.

Environment Scenario

You have created a new ClearQuest user
database using the ClearQuest Designer tool. Itis
essentially an empty shell. We will call this new
database TARGET USERDB.

You also have an existing ClearQuest installation
with a potentially different schema and different
user database. We will call the existing user
database SOURCE_USERDB.

Step 1 - Target Schema Preparation

Ensure that destination ClearQuest schema has
taken into account any existing change request
data from the source database. You need to
make sure the right data types are created and
assigned for all of the data you import.

You will also want to create two new fields in the
destination ClearQuest schema to capture legacy
ID and State information.

e Old_ID

e Oldstate

Step 2 — Backup New User Database

This is an optional step. If you have already
populated your TARGET_USERDB with some
correct data that you wish to retain, you should
back it up.

- Launch the MS SQL Management Studio.
- Select the User Database TARGET_USERDB
- Right click Task -> Tools-> Back Up
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- Set for Full back up. Pick a location for the
output database file and click OK.

Step 3 — Export User Data Database

- Pick a date & time for the export of the
existing source user database. Notify your
users to complete their transactions by that
milestone. Typically | would select an over-
the-weekend or holiday migration period.

- Bring up ClearQuest Client as Admin.

- Connect to the SOURCE_USERDB.

- From menu bar click File ->Export->Records

@& IBM Rational ClearQuest
LN Edit View Tools Help

New 4 i ] gl o
Database L4
. > He learQuest Query Results (admin, Covidien@ cvus
& Print.. Cutte se Action_Types r:ntinns l:hlnml; "
Import s _ AssignedNuotification
I " Record Templates...
Exit = Records...
elds
= 1 Public Queries
+ 1« PrimReportFormats
# 0 Recently Submitted

% = Find Record History

- After the pop-up appears, select Record
Type: Change Request & Export All Records
and then Click Next. *note — your version of
ClearQuest may this defined as defect.
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B ClearQuest Expont

Select record type ™
{admin, weless cwsn)  Select a record type, and optionally "1 ,-g’
choose a query that selects the records to be exported
Record type: 3
Records

() Export all records
) Export records based on an existing query

- Select Add All to add all the fields to the
Export Fields box and then Click Next.

Select fields -

(admin sl o Select the fields to be ncluded in the oport file. & 2
Double click or drag and drop the fields to be exported

Fields: Export fields:

« (2 Change_Request - alfected_components A
O altected_componen ot_field_history
O ot_field_history Anachments
O Attachments ::‘W oot
O category component
O classification defect_title
O component defer_until
O delect_title Description
O defer_until x F—
O Descriotion o dware_configur
< » ! k: .“'e -
l’\&'{(’_} << Remave ol

<Back | Next>

- After the next dialog box appears, select Add
All to add all the fields to the Export Fields
box and then Click Next.
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B ClearQuest Export %)
Select fields
(admin  cossen cwes) Select the fields to be included in the export file. 5 2
Double click or drag and drop the fields to be exported
Fields: Export fields:
« 2 Change_Request - affected_components A
O affected_componen at_field_history
O at_field_history *;“;;Y‘"““
cates
g ::umm‘ classification
egory component
0 classdication detect tithe
O component defer_until
O defect_title Deseription
O defer_until :::' i onfi 2
s o = are_configuration
. O Descrigtion . Headk .
Add al2> | (<< Remave al|
(<Back [ Nea> ] [Concet ]

- After the next dialog box appears, keep the
defaults (Format, Code Page, Delimiter, and
0 —to include all records) and Click Next.

2 ClearQue: (por
Export tool settings
{admin,t s cs)  Specily export output settings s B - J
Format: ClearQuest import format v
Code Page: UTF-8 v
Delimiter: . e
Number of records per file: 0
(Enter 0 to include all records)
| < Back i Next > ] Cancel

- Use the Browse button to set where you
want your data to go (.txt Files), and again
for where you want the attachments to be
copied and Click Finish.
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B ClearQuast | xpart F
Specify file names
[ v, oo wwnene | Entee the e names for the export iles. Existing files will be 1

overwailen durmg export

Export directory: C'Carlos_Foldor SPK Customer s sl TEMP Faumse
Export file name: Change foquest_records ta
Optasnal

+ Hintory file masme Change_Hoquest_history txt

~ Duplicates file name:  Change_Roguest_dughcates. b

~ Astachments file name. Change Fequest sttachments ta

Atachments drectory. CCarlos_Folder SPK Cuntommer < s TE WP Beowne

You now have four CSV text files representing the
defect data in the original User Data Base.

Repeat Step 3 for as needed for additional fields

such as:
e Reference Records (RAProject)
e Customer

Step 4 - Create Reference .txt files

- Repeat Step 3 again (export) this time
replacing the source database
(SOURCE_USERDB) with the target
(TARGET_USERDB). Place the result .txt files
in a different location. You will use this data
as reference information.

- When done, exit out of ClearQuest Client.

Step 5 — Cleaning and preparing the files for
import

You now have four CSV .txt files representing the
old User DB data, and four CSV txt files
representing the new User DB (which is mostly
empty). As the target ClearQuest Schema
database has changed (new states, Fields, etc),
you need to create a third batch of .txt CSV files
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which are aligned. Once done, you’ll use them
for the import.

My preferred method is to start with the
Change_Request_Records.txt files.

e Open the OIld - (SOURCE_USERDB)
exported Change_Request_Records.txt

e Open the New - (TARGET _USERDB)
exported Change_Request_Records.txt.

Use the new version as the master for the
header row. Clean up your data. i.e. for each
CR to be imported, make sure all the records
are accurate to the new schema (valid state,
valid fields). The format for the data is:

"dbid","id","Description" etc

Do the same for the
Change_Requests_history.txt (If you want
the history)

Do the same for the
Change_Requests_duplicates.txt (If you have
existing duplicates to import)

Do the same for the
Change_Requests_attachments.txt

When you have finished scrubbing your data,
you are ready for importation.

Step 6 — Importing your data into the new user
database

Bring up ClearQuest Import Tool

Start -> All Programs -> IBM Rational -> IBM
Rational ClearQuest -> ClearQuest Import
Tool
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- Select the target schema repository in next
pop up dialog.

- Next, when the import login dialog comes
up, login to the tool:

Login: [Account with Admin Privileges)
Password: [Password]

Database: [Your Target User Production DB] —
TARGET_USERDB

- Select Record Type as Change_Request .
Select the type of data you wish to import
(all three boxes). And Click Yes to override
exiting data. Then Click Next.

*** If you have Reference Records (RAProject),
do it before Change_Request (aka defect) ***

& ClearQuest Import Tool - Step 1 of 5

Flease provide information regarding the data you will be importing

Step 1
Please select the Record Type 1o which you will be importing,

Record Type: [ ~ |

Step 2

Pleasze specify the type of dats you will be importing. Selact all that apphy.
[* Recond Data
[ History
[+ Asachments

Step 3

Ave you imporing updates to existing data records in your ClearCuest user database?
® ‘Yes

" MNo

Mot » Cancal Help

- Select Input files, the Discarded Files (which
holds failed imports), the delimiter (,) for the
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. . @ ClearQuest Import Tool - Step 4 of 5
Record, History, and Attachment fields.
Then Click Next e e
Field Label| Destination Data Type| Saurce Field Label | Original identifier of R =
1 affected_components MULTILINE_STRING afipcted_components
@ ClearQuest lmport Tosl  Step 2 ol 5 2 at_field_histony REFEREMCE =
¥ Amachments ATTACHMENT_LIST Attachments {k
L e T T e e e 4 | catagory REFERENCE categony
5 dassificaion SHORT_STRING classification
The m'h«'?‘-u L L s e L L e L ) B component SHORT_STRING | componem
;\.. :!-uTnn Dot g il (Tt s @ TTHT B ) POt G ] ST R 7 defect_sie SHORT_STRING defect_title
v F i Dbt 1 P Oebester Bt Leparsia 1 B Al el cBue @ P rrd e 8 defer_until DATE_TIME deder_until
Ve [iabs E Description MULTILINE_STRING Description
- - 10 oo SHORT_STRING eco
Faa b e Fondedt UEY u witiened LAY barge Feger » 1 Broere — =
" J ~ p—— o 11 hardware_configuration SHORT_STRING | hardware_configuration
[P NP e p— TEMP e _Peawr_rec »| 1Bowe | 12 Headiine SHORT_STRING Headine
[—— - 13 identiby_solution SHORT_STRING identity_solution
14 implementation_datals MULTILINE_STRING | implementation_details
15 lenywvard_1 SHORT_STRING keyword_1
Hatcry Dot E 16 kayword_2 SHORT_STRING keryword_2 -
e TEMPOharge_Faguer bt »| 17 Viam e BT A TR ¥ sasrirrle
et iy Ponee J . e ik arepe P »| JBome L y
Discarded Dalalog [0 'Caton_FollenTF% (Cuntomen TEMCharge_Faguern et » | 4 Drowse
Pt D pes Load Save
Ay gt [y
[ a— R R T a— TAE harge_Fagad_stn » _l,_m-.. : = oo = | el ]
Discarded Dntalog |0 'Caton_F oiden Sy Curtorer TEM Charge_Feguert_sts » | | § Browe I
F ot Cipierones -

- Then scroll down and assign Source ID to

Destination Old_ID. Then click Next
- For the next dialog popup, leave defaults of

State Field Column as ”State” and @ ClearQuest Import Tool - Step 4 of 5
ClearQuest Field Name as “ld”. Leave s e g s oo el s R 50
Importing Duplicates as unclicked. Select

Destination Field Label| Destination Data Type| _Source Field Label | Original Identifier of R &
. (10| eco SHORT_STRING eco
Old_ID as your ClearQuest Field Name and T bardvere, conigurion | SHORT_STRING | hrivers. congskon
- 1z | Headline SHORT_STRING Headline
H 13 | sdaritity_sokmion SHORT_STRING dentdy_solubon
CIICk NeXt 14 | implementation_detads MULTILINE_STRING impementaton_details
15 | keyword_1 SHORT_STRING keyword_1
16 | keyword_2 SHORT_STRING kinyword_2
17 Keywords MULTILINE_STRING Eeywords
@ ClearQuest Import Tool - Step 3 of 5 5| Nota_Entry MULTILINE STRING Note_Entry
19 | Nates_Log MULTILINE_STRING Hotes_Log
Please specily the kind of informsation you heve in your data file(s). 20 C HORT_STRIN [ d -]
21 | opened_dabe DATE_TIME opened_date
Imposting State Values 22 | Cwner REFERENCE (o
lfyour recosd data input data fil2 has state values, and you would like to import those values, please specify the fisld FE] phase SHORT_STRING phasze
calumn in vour fila thet contains this value. 24 | Pricrity SHORT_STAING Priarity
State Field Column T ~ | 25 | proj_phese_completed | SHORT_STRING | proLphese_completed
7% | nuni nhaca nnsinsiad SHAET STEMG  nm nhaca neninstr ¥
< Ed
Imparting Duplicates

[~ Will you be importing records that are marked as dupbicates in your record data input file?

Load Save .

Importing Record Updates. Cuplicates. History, or Atachmants.
you will be importing duplicates, histony. afachments. of record updates into your ClearCuest user databaze, each

diata input file must contain & unique identSer o link the records, history, or stomd
files. Flease speciy the Cleatues! field that will contain th o

<Back Nest> e | Hep |

g

ClearOuest Fiakd Name: ||:||.1_|D :.J

- For History data. Map display_name in
Source to Old_ID in Destination Field

< Back et 3 Exit Help

- The next window will show all the field
mappings for the Change Record Data. First
remove the at_field_history from the source.
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@ ClearQuest Import Tool - Step 4 of &

Flease enter the held mapping tetwesn your data input file and the ClearOuest islds in your record type
Curmrenthy Mapping: Histony Date
Desti Fiald Label| Destination Data Type| Fiald Label Original Identifier of Referrad
1 action_name | SHORT_STRING | action_name
2 acton_tmestamp DATE_TIME schon_tmestamp
3 comments | SHORT_STRING | Comments
4 new_state SHORT_STRING new_state
5 displey_nefne  +]
B old_state | SHORT_STRING | old_state
7 user_name SHORT_STRING USET_name
] >
Loac .. Seve.
Bock [ ety | ea | Hep |

- For Attachment data. Map display_name in
Source to OIld_ID Destination field again
Click Next

& ClearQuest Import Tool - Step 4 of 5

Please enter the Sield mapping betwaen your data input file and the ClearCQuest fields in your record type.
Currently Mapping  Attachment Data

Desti Fiald Labsl| Destination Data Type| Source Field Label Original Identifier of Refered
= Annchments | ATTACHMENT_UST | Amnchments
2| descripson SHORT_STRING Description
3 | oOld_ID SHORT_STRING display_name
< ¥

< Back N > Exnt | Help |
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- Now you’re ready to run the import. Click
Import

@ CloarQuest lmport losl - Step S ol &

Baiom i 0 warrerary of et enporf parametens | e sfomston o noored Deete e Be mieed | Back baton o
CoNECT Pap Batn ] Tube) /s 10 Fus (nge F o B shormmaiein K506 ) COMBCT 0a) ety eceite] wilh Wag b0
I

Sameary

Seuremary

Fipcord Type = Change_Paguey

Type of Dot 0 mpo= = Fpcord Data Hntory Data. ARactnes Data

Lpgeadng = ey

FRacord Deta input Fie « CYCanton_FoldeASPY\Cumomed s TEMPA TEMP R Change_Raquedt_secords W
Fiatord Dema Log File » CyCancs_Folder, 5PV (Csstome v TEMFY arge_Fegue!_meconds_decended
Fiartord Do Dobmier -

Feviory Date Ingest File « CiCancs_Folded SPY\Custormer o TEMFYCharge_Fusguet_Pustor, _updated
Feviory Diate Log Fie = C\Cartos_FobaenSPYCusiomen o TEMIPC hange_Fargue it Peokor, deis aeded bt
Fuvtory Dite Diabervter =

iAsachemant Dt input Fie = C\Carios_F olded SO Cusomed — TENE
" hange Fegues sBachments pdamed b

A mer et Tiotm | 2on Ed o (0 arbnd Forboast TR Catrvmmt TEwe
Flacords Scomeed @ Ewors @

SEOChy Mrw Mty #rvOrT SNCOUARN 1 Tl T et 5

YOu sy WP B mpod Proceis by Chchang on fae buion

- You should see a progress bar. Once done

you can review errors by scrolling the
window. Failures should be corrected and
rerun from the discard file. Don’t re-input a
successful  record or you will get
duplications.

@ ClearQuest lmport Tool - Step 5 of 5

Furpitued svgonng OO0 Folded SEVICuiome « cmee TEWEY hange Faguest smachrenrs oposed b

Sty

CXRRCRr el Ul W b i = LW
Alhange_Fegeest stactrmests

iamacheraet Date Log File = CyCanon_Folder SFY\Customen i TEMS
hChange_Flegemn_ aeactemesn _Sicarded i

e L N

Fuacord Dats ingas Fide Sinte Fuaid Colure = State
mportng Dupbcates « to

e Crvartly Inp0nng Fascond Crate m——

it Fibg = CACarion_FoidehSFYCiastome TEMP\TEMP N1 Change_Paques_reconts 8

Froces 1o record st 1 -

Recosds Scarned 1 Emcn 0
SEENEENEENEENEEENENEENENNNANNENENNEERENENEENE
Spachy HOw mary SO SNCoUTINEd 1D WeTnaie T OO -

TOu My ¥Iop e RO PIDOR By CHOANG On e Bulon

N i B
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- Next you will input the duplicates. If you
don’t have duplicates in your database, skip
ahead to Step 7. Click Import New on the
prior dialog box. Or bring up the import tool
again.

- Select Change_Request for Record Type,
Click Record Data and click Yes to import
records to existing database.

& ClearQuest Import Tosl - Step 1 of &

Tlease provade informaton regarding the data you will be impaorting
Step 1
Flaase select ha Record Tyoe to which you will ba imparting.

Fecord Type Change_Request "J

Step 2
Please specdy the type of deta you will be imporing. Select all that apphy.

[# Record Data
™ History
[~ Asachments

Step 3

Are you importing updates to existing data records in your ClearQuest user databaga?
® Yes
i~ No

Mea» I Euit Halp

- Browse to select your
Change_Request_duplicates.txt file. Browse
to create a
Change_Request_duplicates_discard.txt file.
Click Next

@ ClearQuest lmporn Tool  Step 2 ol 5

Flasse spacy B Wdcmrs) [-aaratecs i om ) Soie g oo wilf b rparinng

The ages §im cortany P 001 r S et et ! gt fevett S0 1 b Be rgaried
The Cmicarded [atn Fin ol cordmn b, oo Bt doae nd 300 epcred sacceishid,
The Fupsd Dabarnige 4 Pup i Bopl s =aente s Pus basts fre] cmbons = P rged bn

Fascon Dass

ngas Fip tinese P RS e — TEASATENS N (hange_fe w| | Beowse
Cracmpded Dete Log artcn_Fokderd S5 uniored TEMATEMP A Change_fa w | | 2 Beowse
¥ et Datrvte -

€ Back Pt 3 [ Hep
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For the next dialog box, leave the State Field
Column Blank. Click the box on “Importing
Duplicates” and select dupid for the
duplicate ID Field Column. Set the
ClearQuest Field name as Old_ID. Click Next

& ClearQuest Import Tool - Step 3 of &

Flease specily the kind of wiou hene in your d

Importing State Values

Wyour record data input data file has state values. and you would like to import those values. plaase specly the field
column in vour file thal containg this valug.

StataFisd Column I ~ |
Importing Duphcates

[+ Wil you be importing records that ase marked as duplicates in your record data input Be?

Please specity the field column in your record data input e thet contains the parent identifier
Dupdicate ID Field Colume:  [dupid |

Importing Rscord Updates, Duplicates. History. or Afachrmants

you will be importing dupiicates, histony. atachments. or recod updates into your ClearOues: user database, each
deta input file must contain & unique idenser to knk the records, history. or attachments storedin the different input
files. Please spacity the ClearQuest field name that will contain this unique identifier.

ClaasOuest Field Name: [ora_D -

< Back Mg » Exit Help

If you get a pop up asking for the optional State
information — click No

- For the next dialog box Click Next. Map
source field ID to destination field Old_ID.
Map source field oldstate to destination field
oldstate. Click Next

@ ClearQuest Import Tool - Step 4 of 5

Please ener the field mapping betwsen your data input file and the ClearQuest fields in your record type
Cumenthy Mapping Record Data

Destination Field Label| Destination Data Type| Field Label| Original Identifier of Refen ~
13 deniry_solution SHORT_STRING
[14 | implementation_details | MULTILINE_STRING
175 | kayword_1 SHORT_STRING
16 | heyword_2 SHORT_STRING
17 Keywords MULTILINE_STRING
18 | Nota_Entry MULTILNE_STRING
R Notes_Log MULTILINE_STRING
20 Qld_ID SHORT_STRING B B
Z oldstate SHORT_STRING oidsaste
122 | opened_date DATE_TIME
] Cwner REFERENCE
E phase SHORT_STRING
25 Priosty SHORT_STRING
[26 | proi_phase_completed SHORT_STRING
127 | proj_phase_orgnated SHORT_STRING
[28 | prol_phase_submited SHORT_STRING 3
2 ranindiirhla CHNET STEA
< »

toed. | Soe. |

<Back Next> Cancel | Hep |
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- After cut-over you may wish to keep the old

- Run the import for the duplicates. Click ClearQuest User Database around. An easy

Import way to accomplish this is to detach the DB

inside MS SQL. This removes the instance

but leaves intact the database, with its data
Peaesimputg CiDm A IOwe SIINTS T yichos AuondLiuliosin ¢ files and transaction log files.

@ ClearGuest mpedt Tosl  Step 5 of &

Link to Instructions are here:

http://technet.microsoft.com/en-
us/library/ms191491.aspx

Rgcoedn Soareed | Evom

L e e e e R T

Carlos Almeida
SPK and Associates
Architect, Software Engineering
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- You should see a progress bar complete.
You can review errors by scrolling the
window. Failures should be corrected and
rerun.

Step 7 — Testing Your New User Database

- Launch the ClearQuest client and exam the
data. Are all the records there? Are they in
the correct state? They will have a new ID
[UserDB]XXXXXXXX, which is ClearQuest
requirement when importing data. You can
create a query to view the Old_ID field which
will map back to the original DB.

- Minor problems should be corrected in
place. More serious issues would merit a
restore of the user database created in Step
2.



